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1. Introduction to Kernel for Novell GroupWise to Exchange  
Welcome to the user manual for Kernel for Novell GroupWise to Exchange, result-oriented and effective email 

migration software that helps you to migrate from Novell GroupWise to MS Exchange Server. It easily exports user 

mailboxes, calendar, tasks, trash items, sent items, documents, checklist, work in progress, cabinet, Unicode 

characters, journals, notes, archives, personal address books and all the existing folders from GroupWise mailboxes 

and stores them in the user's new mailboxes on MS Exchange Server or to Personal Storage Files(.PST). 

Kernel for Novell GroupWise to Exchange software provides secure migration services to transfer mailboxes to MS 

Exchange Server, Office 365, MS Outlook PST files and Live Exchange Mailboxes. Users can migrate Single 

GroupWise Mailbox or Unlimited GroupWise Mailboxes in a particular migration cycle. 

This user manual comprises step by step guidelines on using Kernel for Novell GroupWise to Exchange. 

1.1 Using this Manual 

This user manual is intended to guide users on using Kernel for Novell GroupWise to Exchange. We suggest that 

first time users should read this user manual thoroughly and carefully before proceeding to use the software. 

However, if you are an experienced user, you can use the table of contents to find out information about the tasks 

that you need to perform by using Kernel for Novell GroupWise to Exchange. You can use the table of contents to 

navigate through different sections of this user manual. The table of contents lists all the sections that are contained 

in this user manual in chronological order. The user manual comprises the following sections: 

▪ About Kernel for Novell GroupWise to Exchange. 

▪ Getting Started. 

▪ Migration from Novell GroupWise to Exchange Server. 

▪ Advanced Options to Make the Migration More Efficient. 

▪ Difference between Evaluation and Full Version. 

▪ Purchase and Support. 

▪ Legal Notices. 

1.2 Who should use this Software? 

The capability and potential of Kernel for Novell GroupWise to Exchange software to perform the migration 

smoothly and accurately make it the preferred and best choice for organizations that want to switch from Novell 

GroupWise to MS Exchange Server, which generally takes days and hours to complete. 

The software is also helpful to Administrators and Technicians, who need to perform migration from Novell 

GroupWise Server to Microsoft Exchange Server, Office 365, Outlook PST files or Live Exchange Mailboxes, so that 

their organizations can avail the advance functionalities of these platform for particular purposes. The need for 

migration from Novell GroupWise to a different platform arises due to accessibility issues, server maintenance 

charges, security reasons and increased help desk cost associated with Novell GroupWise server. 

1.3 Introduction 

Once you download the software setup of Kernel for Novell GroupWise to Exchange, two applications get installed 

on your system. One is the main application – Kernel for Novell GroupWise to Exchange software and second is a 
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batch file creation tool – Kernel for Novell GroupWise to Exchange Migration File Creator. Both the applications are 

discussed below. 

1.3.1 Kernel for Novell GroupWise to Exchange 

Kernel for Novell GroupWise to Exchange is an advanced and result-oriented email migration software that easily 

exports every item of GroupWise User Mailbox, i.e. emails, contacts, calendars, sent items, trash items, documents, 

checklist, Unicode characters, cabinet, work in progress, journals, notes, appointments, archive items, etc. 

Two choices are available to the user for migration - Single Mailbox Migration and Multiple Mailboxes Migration. 

Single Mailbox Migration option converts one mailbox at a time whereas Multiple Mailboxes Migration option 

converts unlimited mailboxes at a time. 

1.3.1.1 Salient Features 

Migrates from GroupWise to Exchange 

Converts Single GroupWise Mailbox 

Converts Batch of GroupWise Mailboxes 

Batch file migration through imported MS Excel worksheets 

Migrates archived GroupWise items 

Migrates complete Address Books 

Migrates securely and accurately 

Saves converted mailboxes in PST or MS Exchange Server user profile 

Supports every version of Novell GroupWise, MS Exchange Server, MS Excel, and MS Outlook Free Evaluation 

version to analyze the software 

Exports GroupWise Mailboxes to Live Exchange Mailboxes Migrates GroupWise Mailboxes to Office 365 account 

1.3.1.2 Graphical User Interface 

Now that Kernel for Novell GroupWise to Exchange has been installed on your computer, you can start using the 

software after getting acquainted with the software interface. 

Menu Bar 

The menu-bar of Kernel for Novell GroupWise to Exchange comprises three main menus– File, Tool and Help. 

File Menu 

The File menu comprises four menu items. 
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Figure 1.1 File Menu of Main Application                                              

   

Menu items in the File menu:  

  

 

 

 Field Name Field Description 

   

 Single Mailbox Select to convert Single GroupWise User mailbox 

 Batch File Select to convert Multiple GroupWise user mailboxes saved in a 

  NUCON batch file 

 Export Select to export/save items of the mailbox 

Tool Menu 

The Tool menu comprises one menu item. 

 

Figure 1.2 Tool Menu of Main Application 

Menu items in the Tool menu: 

Field Name Field Description 

Advanced 

Options Select to view advanced options to customize various activities 

Help Menu 

The Help menu comprises three menu items. 
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Figure 1.3 Help Menu of Main Application 

Menu items in the Help menu: 

Field Name Field Description 

  

Help Select to view Users Help Manual of Kernel for Novell GroupWise 

 to Exchange 

Software home Select to visit the homepage of the software on our website 

page…  

About Kernel Select to know version information and support details of Kernel 

for Novell for Novell GroupWise to Exchange 

GroupWise to  

Exchange  

Tool Bar 

The tool-bar in Kernel for Novell GroupWise to Exchange is displayed below the menu-bar. The tool-bar provides a 

convenient and user-friendly method to perform specific actions that can also be achieved by using the menu-bar. 

Read the information in the table below to find out about the tool-bar buttons: 

Button Button Name Button Description 

 

Single Mailbox 
Select   to  convert   Single   GroupWise   User 

mailbox 

 

Batch File 
Select to convert Multiple GroupWise user 

mailboxes saved in a batch file 
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Export Select to export/save items of the mailbox 

 

Help 
Select to view Users Help manual of Kernel for 

Novell GroupWise to Exchange software 

 

Buy Online 
Select to purchase Kernel for Novell GroupWise 

to Exchange software 

Status Bar 

The status bar is displayed at the bottom of the software window. The text “www.nucleustechnologies.com” is 

displayed on the status bar when you open the software. This text changes according to the actions performed 

with the toolbar buttons. For example- Status bar shows the text “Single File‟ when you put mouse on Single File 

button to perform single file conversion and then changes back to “www.nucleustechnologies.com.” 

The Status bar also displays the text ‘CAP,’ ‘NUM,’ ‘SCRL’ which respectively correspond to the Caps Lock, Num 

Lock, and Scroll Lock keys on your keyboard. If any of these keys are pressed, the color of the corresponding text 

will turn blue/black. 

 

Figure 1.4 Status Bar of Main Application 

Button Used 

Apart from the standard options available in the menu-bar and the tool-bar, the following are the main buttons 

used throughout the software working. 
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Customize User Interface 

You can add or remove toolbar buttons by clicking: 

 

→ 
Add or Remove Buttons 

→ 
Standard in the toolbar and selecting appropriate buttons. 

1.3.2 Kernel for Novell GroupWise to Exchange Migration File Creator 

Kernel for Novell GroupWise to Exchange Migration File Creator creates a .NUCON batch file that lists and records 

details of unlimited GroupWise user mailboxes for conversion to PST or MS Exchange Server. Batch file eliminates 

the pain of converting GroupWise User Mailboxes one by one. Creation of batch file saves the valuable time of 

administrators/technicians. 

 

Kernel for Novell GroupWise to Exchange Migration File Creator has the feature of importing MS Excel worksheet 

that is used to store complete information about the Novell GroupWise user mailboxes. 

1.3.2.1 Graphical User Interface 

As the batch file creation tool - Kernel for Novell GroupWise to Exchange Migration File Creator has been installed 

automatically on your computer system with the installation of Kernel for Novell GroupWise to Exchange 

software; you can start creating batch file to perform multiple mailboxes migration after getting acquainted with 

the software interface of batch file creator tool. 

The menu-bar of Kernel for Novell GroupWise to Exchange Migration File Creator comprises four main menus – 

File, Edit, View, and Help. 

File Menu 

The File menu comprises six menu items. 

 

Figure 1.5 File Menu of File Creator 

Menu items in the File menu: 

Field Name Field Description 
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New File 

Select to remove all existing records listed in the Kernel for Novell 

GroupWise  to  Exchange  Migration  File  Creator  software  and 

create new record for a new batch file 

Add Record Select to add new record of the user mailbox in a batch file 

Open Select to open an existing .NUCON batch file 

Save Select to save the .NUCON batch file 

Save As 
Select  to  select  the  location  on  your  hard  drive  to  save  the 

.NUCON batch file 

Exit Select to exit from the software 

Edit Menu 

The Edit menu comprise of single menu item: 

 

Figure 1.6 Edit Menu of File Creator 

Menu items in the Edit menu: 

Field Name Field Description 

  

Remove Select to remove the selected record from the list 

View Menu 

The View menu comprises two menu items. 

 

Figure 1.7 View Menu of File Creator 

Menu items in the View menu: 

Field Name Field Description 
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Toolbars Select  to  view  or  hide  toolbar  of  Kernel  for 

Novell GroupWise to Exchange  Migration  File 

Creator software 

Status Bar Select to view or hide status Bar of Kernel for 

Novell GroupWise  to Exchange  Migration  File 

Creator software 

Help Menu 

The Help menu comprises three menu items. 

 

Figure 1.8 Help Menu of File Creator 

Menu items in the Help menu: 

Field Name Field Description 

Help  Select to view help information pertaining to performing various tasks 

using Kernel for Novell GroupWise to Exchange Migration File Creator 

Software Homepage Select to visit homepage of our website 

About Kernel for Novell GroupWise to 

Exchange Migration File Creator 

Select to view version-related and support information of Kernel for 

Novell GroupWise to Exchange Migration File Creator 

Tool Bar 

Following are the tool bar buttons used in the Kernel for Novell GroupWise to Exchange Migration File Creator: 

Button Button Name Button Description 

 

New Select to remove all existing records listed in the 

Kernel   for   Novell   GroupWise   to   Exchange 

Migration  File  Creator  software  and  create  new 

record for a new Kernel batch file 
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Open  Select to open the existing .NUCON file 

 

Save Select to save the .NUCON batch file 

 

Save As Select to define the location on your hard drive to 

save the .NUCON batch file 

 

Add Record Select to add the records/details of the 

GroupWise user mailbox and saving options 

 

Remove Select to remove the selected record from the list 

 

Help Select to view User's Help Manual of Kernel for 

Novell GroupWise to Exchange Migration File Creator software 

 

Import Excel Select to import excel worksheet with added 

information about the batch of GroupWise mailbox(s) to be migrated 

Status Bar 

Status bar is displayed at the bottom of the software window. The text Ready is displayed on the status bar if 

Kernel for Novell GroupWise to Exchange Migration File Creator is ready to be used. Status bar also displays the 

text CAP, NUM, SCRL that respectively corresponds to the Caps Lock, Num Lock, and Scroll Lock keys on your 

keyboard. If any of these keys are pressed, the color of the corresponding text will turn blue/black. 

 

Figure 1.9 Status Bar of File Creator 

Customize User Interface 

You can add or remove toolbar buttons by clicking: 

 

     
→ 

Add or Remove Buttons 
→ 

Standard in the toolbar and selecting appropriate buttons. 
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2 Getting Started 
 

Now that you have understood the features and potential of Kernel for Novell GroupWise to Exchange, you are 

ready to get hands on experience of the software. To start migrating files, you will first need to download and 

install this software. However, it is strongly recommended that before installing Kernel for Novell GroupWise to 

Exchange, you should go through the installation pre-requisites for the software to ensure that your computer is 

appropriately configured to run the software. 

 

2.1 Installation pre-requisites and system requirements 

The various pre-requisites for installing and running Kernel for Novell GroupWise to Exchange can be broadly 

classified into two major categories – Hardware requirements and Software requirements. 

2.1.1 Hardware Requirements 

The hardware requirements for installing the software are as follows: 

▪ Pentium Class Processor 

▪ Minimum 64MB RAM (128 MB recommended) 

▪ 10MB for Software installation 

▪ Disk Space - Enough space to save the results 

 

2.1.2 Software Requirements 

The software requirements for installing the software are as follows: 

2.1.2.1 Operating System Requirements 

Supported operating systems:  

▪ Windows Vista ▪ Windows 10 ▪ Windows NT 

▪ Windows XP ▪ Windows 8.1 ▪ Windows 95 

▪ Windows 2003 ▪ Windows 8 ▪ Windows 98 

▪ Windows 2000 
▪ Windows7  

2.1.2.2 Novell GroupWise Server Requirements 

Supported Novell GroupWise Server versions: 

▪ Version 6, 6.5, 7.0, 8.0, 2012, 2014 

 You should have at-least 10 MB of free disk space if you want to export and save 10 MB .PST file. 
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2.1.2.3 MS Outlook Requirements 

Supported MS Outlook versions 

MS Outlook ( 97, 98, 2000, 2003, 2007, 2010, 2013, 2016, 2019). 

2.1.2.4 MS Excel Requirements 

Supported MS Excel versions: 

MS Excel 97, 98, XP, 2000, 2002, 2003, 2007, 2010, 2013 and 2016 

2.2 Downloading Kernel for Novell GroupWise to Exchange software for the First 

time 

After checking your computer with the prescribed system requirements for Kernel for Novell GroupWise to 

Exchange, you can download and install the software on your computer. You can buy the full version of the 

software from any one of our authorized resellers– Element5, Asknet and 2CO. 

If you want to try using Kernel for Novell GroupWise to Exchange before buying it, you can download the 

evaluation version from the following link: 

https://www.nucleustechnologies.com/migrate-groupwise-to-exchange.html 

 

 

 

 

2.3 Installing Kernel for Novell GroupWise to Exchange 

After downloading the installer file for Kernel for Novell GroupWise to Exchange, you can install the software by 

running the file. 

To install Kernel for Novell GroupWise to Exchange: 

1. Double-click the Kernel for Novell GroupWise to Exchange installer. Follow the on-screen instructions. 

2. The Setup Installation Complete screen will be displayed. 

3. Click Finish to launch the software. 

 

 

 

 

 You can export unlimited GroupWise files saved on your system by using the evaluation version of 

Kernel for Novell GroupWise to Exchange; however, the evaluation version lets you save 10 emails per 

folder of the converted GroupWise mailbox. 

 When you run the Kernel software setup, two programs get installed in the All Programs menu and 

two desktop icons are created: Kernel for Novell GroupWise to Exchange.exe and Kernel for Novell 

GroupWise to Exchange - Batch Migration File Creator.exe 

https://www.nucleustechnologies.com/migrate-groupwise-to-exchange.html
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2.4 Uninstalling Kernel for Novell GroupWise to Exchange 

You may need to uninstall and re-install Kernel for Novell GroupWise to Exchange. To uninstall Kernel for 

Novell GroupWise to Exchange: 

1. Click the Start>>All Programs>>Kernel for Novell GroupWise to Exchange>>Uninstall Kernel for Novell GroupWise 

to Exchange. 

A warning message will display. 

2. Click “Yes‟ to uninstall Kernel for Novell GroupWise to Exchange.  

 

 

 

 

You can alternatively uninstall Kernel for Novell GroupWise to Exchange from the Control Panel by performing the 

following steps: 

1. Click the Start Menu>>Control Panel and then double click the Add or Remove Programs icon. 

2. Select Kernel for Novell GroupWise to Exchange and click Remove. 

A warning message will be displayed. 

3. Click “Yes‟ to uninstall Kernel for Novell GroupWise to Exchange. 

3 Migration from Novell GroupWise to Exchange Server  
Now that you have complete familiarity of the user interface of Kernel for Novell GroupWise to Exchange, you are 

ready to perform the migration of GroupWise mailbox(s). 

3.1 Single Mailbox Migration 

1) Launch Kernel for GroupWise to Exchange. 

 Before proceeding to uninstall Kernel for Novell GroupWise to Exchange, you must ensure that the 

software is not running. 
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Figure 3.1 Main Window of Kernel for GroupWise to Exchange 

2)  Select the radio button “Select this option to convert single GroupWise Mailbox‟ and click Next button. 

On clicking “Next‟ , window displays three modes to connect to the mailboxes of Novell GroupWise and archive 

selection option: Default Mode, Login Mode and Command Line mode. 
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Figure 3.2 Windows showing three modes 

3) Choose any of the modes as per the requirement and perform migration of Single GroupWise mailbox. 

Default mode: This mode converts the items of currently opened mailbox in GroupWise Client. 

Login Mode: This mode provides sub-modes, where mailboxes can be connected and converted with Online 

details, Caching Mailbox Path and Remote Mailbox path of the mailbox file. 

Command Line Mode: This mode helps to access and convert GroupWise mailbox without accessing or opening 

the GroupWise Client. Items of the mailbox are easy to convert by typing complete mailbox path: /pr-/"mailbox 

destination location" 

3.1.1 Default Mode 

Default mode migrates the currently opened user mailbox in Novell GroupWise client. 
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Figure 3.3 Using Default Mode 

 

 

 

2. Activate and select the Archive file options to migrate archived emails. Click Next button to continue. Software 

shows all the existing folders in a tree like structure. 

3. Select any of the tabs to view the preview of selected email in either Text or HTML format. 

 This option is enabled by default in the software 
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Figure 3.4 Preview Window 

Emails, calendar, contacts and other items will be displayed in the left pane of the window. Right pane of the 

window displays the respective items of the folder selected from the left pane. Bottom pane displays the preview 

of the item selected from the right pane of the window. 

4. Click Export button to continue. 

Software asks for the Save Options whether to Save in PST, Save in Live Exchange Server or Office 365. 

 

Figure 3.5 Save Options 

5. Select the appropriate radio button and click OK button. 

3.1.1.1 Saving in PST 

To save the GroupWise mailbox items in PST file: 
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1. Select the "Save in PST" radio button and click OK. 

 

Figure 3.6 Saving in PST 

2. Filter email items by selecting item types and defining date range parameters. Define PST Folder Path and PST 

File Name and click Export. 

 

Figure 3.7 Windows asking for email item filtration and PST file location to save 
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Software starts saving selected folders at the selected location. 

 

Figure 3.8 Migration Starts 

Emails and other items of the user mailbox are saved in new PST file with original folder structure of the Novell 

GroupWise mailbox. 

3.1.1.2 Saving in Exchange Server 

To save the GroupWise mailbox items in Exchange Server: 

1. Select the "Save in Live Exchange server" radio button and click OK. 

 

Figure 3.9 Saving in Live Exchange Server 

2. Provide the details for Live Exchange Server, User Name, Password, and Domain Name and then click OK. 



 

                                                                                      © KernelApps Private Limited 

                                                                        

Kernel for Novell GroupWise to Exchange Installation & Configuration Guide 

 

Figure 3.10 Exchange Server Information 

3. Select the desired Exchange Server and mailbox from the Live Exchange Server and Mailbox Name drop down 

menu and click OK. 

 

Figure 3.11 Exchange Server and Mailbox Name 

4. Now, select the Source mailboxes that are required to be transferred then click the Mapping button to begin 

the mapping process. 
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Figure 3.12 Source Mailbox for Migration 

5. Select the Target Mailbox to import mailboxes and click OK to proceed. 

 

Figure 3.13 Target Mailbox for Migration 

6. Define email items filtration properties, mention PST Folder Path and PST File Name, and click Export. 
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Figure 3.14 Email Filtration for Migration 

7. Software starts saving the mailbox items in Live Exchange Server user profile. 

 

Figure 3.15 Migration Starts 
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Emails and other items of the user mailbox are now saved. 

3.1.1.3 Saving in Office 365 

To save the GroupWise mailbox items in Office 365: 

1. Select the "Save in Live Exchange server/ Office 365" radio button and click OK. 

 

Figure 3.16 Saving in Office 365 

2. Select Office 365 option and provide the details for Office 365 account, User ID, Password, and then click OK. 

 

Figure 3.17 Exchange Server Information 

3. Now, select the Source mailboxes that you want to export then click the Mapping button to begin the mapping 

process. 
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Figure 3.18 Select Source Mailbox for Migration 

4. Select the Target Mailbox to import mailboxes and click OK to continue. 

 

Figure 3.19 Select Target Mailbox for Migration 

5. Define email items to be included in migration process and click Export. 
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Figure 3.20 Filter Email Item for Migration 

6. Software starts saving the mailbox items in MS Exchange Server user profile. 

 

Figure 3.21 Saving in Progress 
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Emails and other selected items of the user mailbox will be saved. 

3.1.2 Login Mode 

Login mode provides three sub modes: Online, Caching and Remote. 

Online Mode with/without proxy 

1. Select the Online radio button to access the GroupWise mailbox in online mode. 

2. Type the User Id and Password of the mailbox which you want to migrate from Novell GroupWise to Exchange. 

3. Type the IP address and Port number of the computer where Novell GroupWise Server is installed. Click Next 

button to proceed. Check Use Proxy Access checkbox to access any GroupWise mailbox. 

 

Figure 3.22 Using Online Mode 

4. Select any of the GroupWise mailbox items to view its contents and click Export button to save the mails. 
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Figure 3.23 Windows Showing Preview of Files 

5. Software asks for the Save Options whether to Save in PST or Save in Exchange Server. Select the appropriate 

radio button and click OK button. 

The saving process is same as described in Section 3.1.1.1 and 3.1.1.2. 

Caching Mode 

1. Select the Caching mailbox path radio button to access the GroupWise mailbox in cache mode. 

2. Type the User Id and Password of the mailbox which you want to migrate from Novell GroupWise to Exchange. 

Also, define the caching mailbox path with the (...) button. 
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Figure 3.24 Using Caching Mode 

3. Click Next button to proceed. 

4. Further steps are same as step 4 and 5 of above-mentioned Online Mode. 

Remote Mode 

1. Select the "Remote mailbox path" radio button to access the GroupWise mailbox in remote mode. 

2. Type the password of the mailbox, which you want to migrate and define the remote mailbox path through the 

(...) button. 



 

                                                                                      © KernelApps Private Limited 

                                                                        

Kernel for Novell GroupWise to Exchange Installation & Configuration Guide 

 

Figure 3.25 Using Remote Mode 

 

 

 

3. Rest steps are same as step 4 and 5 of above-mentioned Online Mode.  

3.1.3 Command Line Mode 

Command Line mode helps you to access the GroupWise mailbox without opening or accessing the Novell 

GroupWise.exe and user mailbox account. If you know the path where GroupWise mailbox is saved, then type the 

path in Command Line mode and access that user mailbox for migration. 

1. Select Command Line (for advance migration) radio button to perform the migration with Command Line 

Mode. Type the User ID, Password and the User GroupWise Mailbox path. 

 Password is required for only those mailboxes which are password protected, otherwise there is no 

need to provide password for authentication. 
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Figure 3.26 Using Command Line Mode 

 

 

 

2. Click Export button from the toolbar or simply click Next button to continue. 

3. Rest steps are same as steps 4 and 5 of above-mentioned Online Mode. 

3.2 Multiple Mailbox Migration 

Multiple Mailbox Migration lets you migrate unlimited GroupWise files at once. Batch file is one medium with which 

you can easily list and convert unlimited GroupWise user mailboxes at once. Batch file stores records of unlimited 

GroupWise user mailbox accounts. Creation of batch file eases the task of defining saving location and saving mode 

for the converted mailboxes in PST or Live Exchange Server/ Office 365. 

3.2.1 Creating .NUCON Batch File 

1. Launch Kernel for Novell GroupWise to Exchange Migration File Creator software. 

 Remote Novell GroupWise mailbox can be accessed with the switch and the complete path of the 

mailbox which is required to be migrated. 
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Figure 3.27 Main Window of Migration File Creator 

2. Select Add Record option from the File menu or click the Add Record button from the tool bar. 

3. Provide the various related information, as in, user id, password, online, caching mailbox details, etc. 
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Figure 3.28 GroupWise Information 

 

 

 

4. After filling up all the relevant information, click Next button. 

As you click Next, Kernel for Novell GroupWise to Exchange Migration File Creator software provides saving 

options: Save in PST and Save in Exchange Server to choose from it. 

 Select any of the modes (Online, Caching, Remote, and Command Line) to get access to the 

GroupWise user mailbox. 
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Figure 3.29 Outlook/Exchange Information 

5. Select any of the saving option and provide the details accordingly. 

 

Figure 3.30 Information for Exchange Server 
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6. Click Finish button to continue. 

All the created records of the GroupWise User Mailboxes get listed in the software. 

 

Figure 3.31 Created Records 

7. Click the Save button from the tool bar to save the batch file or click the Save As button to select and define 

saving location for the batch file on your computer system. 
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Figure 3.32 Saving NUCON File 

 

 

 

3.2.2 Creating Excel Database 

Excel datasheet is another way of performing multiple mailbox migration. Information regarding various Novell 

GroupWise user mailboxes is easily saved to an excel worksheet according to the provided file format. Save 

details in .XLS file and export it to Kernel for Novell GroupWise to Exchange Migration File Creator software to get 

it saved to .NUCON batch file. 

Excel sheet (.XLS) to be imported should be in the following format. 

 Kernel for Novell GroupWise to Exchange Migration File Creator software by default creates *.NUCON 

file extension for the created batch file for multiple mailbox conversion. 
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Figure 3.33 Created Excel Records 

1. Tab name of the sheet should be NucleusExcelSheet. 

2. Sheet should consist of 19 columns. 

 

Field 1 Mode 

Field 2 User ID 

Field 3 Password 

Field 4 Address 

Field 5 Port 

 Field 6 Caching Mailbox Path 

   

 Field 7 Remote Mailbox Path 

 Field 8 Command Line 
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 Field 9 User Name 

 Field 10 User Password 

 Field 11 Computer Name/IP 

 Field 12 PST File Path 

 Field 13 PST File Name 

 Field 14 Exchange Server Name 

 Field 15 Exchange Mailbox 

 Field 16 Exchange Server Password 

 Field 17 Domain 

 Field 18 Save Archive 

 Field 19 Archive Path 

3. Fill up the fields according to the login type selected amongst. 

• Online 

Following are the mandatory fields to be filled in while using this mode: 

I. User ID: Type the user name of the mailbox. 

II. Password: Type the password of user mailbox. 

III. Address: Type the IP address of the Novell GroupWise Server. 

IV. Archive Details: Always type "NO" in this field if you want to migrate the mailbox items only. 

V. Save in PST: There are two fields in this option: 

▪ PST File Path 

▪ PST File Name 

If you want to save the migrated items in PST file then type the PST path location in both the fields, otherwise it 

will be an error. 

VI. Save in Exchange Server: There are four fields in this option: 

▪ Exchange Server Name 

▪ Exchange Mailbox 

▪ Password 

▪ Domain 
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If you want to save the migrated items to the user mailbox on MS Exchange Server, then all the four fields are 

compulsory, otherwise it would be an error. 

 

 

 

• Caching Mailbox Path 

Following are the mandatory fields to be filled in while using this mode: 

I. User ID: Type the user name of the mailbox. 

II. Password: Type the password of user mailbox (if any). 

III. Caching Mailbox Path: Browse and list the path for Caching Mailbox of Novell GroupWise account to be 

migrated. 

IV. Archive Details: Always type "NO" in this field if you want to migrate the mailbox items only. 

V. Advance Options: Provide details to these fields if you are accessing the Caching mailbox from a network 

computer. This section will comprise of the login details of the computer in network. There are three 

fields in advanced options: 

VI. User Name of the network computer where mailbox is saved 

VII. Password of the network computer where mailbox is saved 

VIII. Computer Name/IP of the network computer where mailbox is saved 

IX. Advanced options fields are not compulsory but recommended. If not filled, it will be shown as a warning. 

X. Save in PST: There are two fields in this option: 

▪ PST File Path 

▪ PST File Name 

XI. If you want to save the migrated items in PST file then type the PST path location in both the fields, 

otherwise it will be an error. 

XII. Save in Exchange Server: There are four fields in this option: 

▪ Exchange Server Name 

▪ Exchange Mailbox 

▪ Password 

▪ Domain 

If you want to save the migrated items to the user mailbox on MS Exchange Server, then all the four fields are 

compulsory, otherwise it would be an error. 

 

 

 

• Remote Mailbox Path 

Following are the mandatory fields to be filled in while using this mode: 

NOTE: Only one amongst “Save in PST” and “Save in Exchange Server” should be filled, otherwise software 

will display an error. 

NOTE: Only one amongst “Save in PST” and “Save in Exchange Server” should be filled, otherwise it will be 

an error. 
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I. Password: Type the password of user mailbox (if any). 

II. Remote Mailbox Path: Browse and list the path of remote mailbox path of Novell GroupWise account to 

be migrated. 

III. Archive Details: Always type "NO" in this field if you want to migrate the mailbox items only. 

IV. Advance Options: Provide details to these fields if you are accessing the Remote mailbox from a 

V. network computer. This section will comprise of the login details of the computer in network. There 

VI. are three fields in advanced options: 

User Name of the network computer where mailbox is saved 

Password of the network computer where mailbox is saved 

Computer Name/IP of the network computer where mailbox is saved.  

Save in PST: There are two fields in this option: 

▪ PST File Path 

▪ PST File Name 

VII. If you want to save the migrated items in PST file then type the PST path location in both the fields, 

VIII. otherwise it will be an error. 

IX. Save in Exchange Server: There are four fields in this option: 

▪ Exchange Server Name 

▪ Exchange Mailbox 

▪ Password 

▪ Domain 

If you want to save the migrated items to the user mailbox on MS Exchange Server, then all the four fields 

are compulsory, otherwise it would be an error. 

 

 

 

Command Line (for advanced migration) 

Following are the mandatory fields to be filled in while using this mode: 

I. User ID: Type the user name of the mailbox. 

II. Password: Type the password of user mailbox. 

III. Command Line: This field is compulsory. If this field is left blank, error will be shown. 

IV. Archive Details: Always type "NO" in this field if you want to migrate the mailbox items only. 

V. Save in PST: There are two fields in this option:    

▪ PST File Path 

▪ PST File Name 

VI. If you want to save the migrated items in PST file then type the PST path location in both the fields, 

otherwise it will be an error. 

VII. Save in Exchange Server: There are four fields in this option: 

a. Exchange Server Name 

 NOTE: Only one amongst “Save in PST” and “Save in Exchange Server” should be filled, otherwise it will 

be an error. 
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b. Exchange Mailbox 

c. Password 

d. Domain 

VIII. If you want to save the migrated items to the user mailbox on MS Exchange Server, then all the four fields 

are compulsory, otherwise it would be an error. 

3.2.3 Importing Excel Database 

Once done with the creation of Excel (.XLS) sheet, you are ready to import the same to Kernel for Novell 

GroupWise to Exchange Migration File Creator and save it as .NUCON file. Follow the given steps: 

1. Launch Kernel for Novell GroupWise to Exchange Migration File Creator software. 

 

Figure 3.34 Migration File Creator Software 

2. Click Import Excel button from the toolbar. Software displays the Open window to select the 

NucleusMigrationFile (.XLS) from the saved location. 
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Figure 3.35 Selecting XLS File 

Browse and list the excel sheet. As you list the file in software, it displays a window with compilation output for 

the total records scanned from the excel sheet. 

3. Modify the excel sheet as per the compilation output provided by the software. If there are no errors then click 

OK to proceed. 

Saved mailbox details get listed in the software. 
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Figure 3.36 Listing of Mailboxes 

4. Click the Save As button from the toolbar to save the listed items as .NUCON batch file at appropriate location. 

5. Launch Kernel for Novell GroupWise to Exchange Migration software- main application and select the option to 

convert batch of GroupWise Mailboxes and list the .NUCON batch file for migration. 

3.2.4 Using NUCON Batch file for multiple mailbox migration 

Now that the .NUCON Batch file has been created, you can easily perform the multiple mailbox migration with the 

help of .NUCON file. Follow the simple steps given below:  

 1. Launch Kernel for Novell GroupWise to Exchange software. The main window appears as 
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Figure 3.37 Home Window 

2. Select the "Select this option to convert batch of GroupWise mailboxes" radio button and click the Next button. 

The "Open" window is displayed. Select the batch file of .NUCON file extension and click the "Open" button. 

 

Figure 3.38 Open Window 

3. Click the NEXT button to initialize the migration of unlimited GroupWise mailboxes to PST or Exchange Server. 
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Figure 3.39 NUCON File Listed 

4. The software prompts a window displaying MS Exchange settings. Select the required options and click OK to 

start the migration process. 

After that, the software starts the saving process and saves the converted items at the defined location. 

 

 

3.2.5 Saving with Exchange Server (for multiple mailbox conversion option) 

Save in Exchange Server option for multiple mailbox conversion is pre-defined while creating the batch file of 

unlimited user mailboxes records in Kernel for Novell GroupWise to Exchange Migration File Creator software. 

Following is the process which gets followed while saving the files in MS Exchange Server user profiles: 

1. Click the radio button Select this option to convert batch of GroupWise Mailboxes. 

 The saving process is same as described above in Single Mailbox Migration section. 
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Figure 3.40 Main Window for Batch File Migration 

2. Click Next to continue. List the .NUCON file (the created batch files) with Select File button. 

 

Figure 3.41 NUCON File Listing 

3. A Batch File Option window will open; select the required options and click start to initiate the migration 

process. 
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Figure 3.42 Batch File Options 

Software will start saving the files in the defined Exchange Server user profiles. 

After successful saving, Kernel for Novell GroupWise to Exchange Server will display the "Saving Complete" 

message, which means that emails and other items of Novell GroupWise mailbox are saved successfully to the User 

mailbox on MS Exchange Server. 

4 Advanced Options to Make Migration More Efficient 
Advanced options are provided in Kernel for Novell GroupWise to Exchange software for the user to ease the task 

of email migration from Novell GroupWise to Exchange mailboxes or PST files, as per the requirement. 

4.1 Migration of Archived Emails 

Kernel for Novell GroupWise to Exchange features migration of archived items of GroupWise user mailbox(s). 

Activate the Show Archive checkbox from the "Migrate Archive items" section. Following two options are provided 

for migration of archived items: 

▪ Use default Archive path: This option takes the default archive file location of the default user profile configured 

and opened in Novell GroupWise client. 

▪ Specify Archive path: This option takes the file path specified by you for archived file for user mailboxes other 

than the default one. 
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Figure 4.1 Migrate Archived Items 

4.2 Migration of All Address Books 

Kernel for Novell GroupWise to Exchange enables migration of all the address books at a go. 

Once the .NUCON file is selected for export, software starts the process of saving. Before starting the process, 

software displays the message for address book migration. 

Click Yes if you want to export address book, otherwise No if you do not want to. 

4.3 Folder Selection for Batch Migration of GroupWise Mailboxes 

Advanced options help you to select/deselect various options that filter your migration process. 

 If you have selected Login Mode(s) or Command Line mode then you should always use Specify Archive 

path option to define archive file location of the user mailbox listed in Login or Command Line fields. If 

Use default Archive path option is selected, then the software will display the archived items of default 

user profile configured in GroupWise for migration. 

 When you opt for archive migration, software will list only the archived file items for preview and saving. 

Other mailbox items are not displayed when you select to migrate archived items. 
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To view and implement advance options select Advance Options from Tool menu. 

 

Figure 4.2 Advanced Options 

4.3.1 Export into Existing folders in Exchange Mailbox 

Select this option, if you want to save the migrated items into existing folders of MS Exchange Server user 

mailbox. 

 

 

 

 

4.3.2 Prompt for folder selection for each mailbox, while using batch file mode. 

Software enables you to select desired folders for saving during batch file migration process. You can select 

appropriate folders for saving while performing migration with Kernel batch file of multiple mailboxes at once. 

When Prompt for folder selection for each mailbox, while using batch file mode checkbox is selected. From this 

window, you can select the folders to save. If you do not want this dialog box to appear again and again, select the 

Never show this dialog again and save all folders or deselect the "Prompt for folder selection for each mailbox, while 

using batch file mode checkbox” from Advance Options. By this all the folders which exist in the mailbox will get 

saved automatically and software will not prompt you to select or deselect the folders. 

4.3.3 Show All Address Books 

Select this checkbox to view all the address books of GroupWise mailbox during mailbox preview before saving the 

items. 

 In case of migrating items from orphan GroupWise folders: for any folder which exists in GroupWise 

mailbox but does not exist in the Exchange server mailbox, software will create a new folder of its 

original name in Exchange mailbox and export items to that folder. 
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4.3.4 Advanced Settings for Sent Items 

Select this checkbox to activate advance settings for Sent Items conversion. If in case, the Sent Items folder emails 

are listed and converted slowly, then select this option to make it fast. Kernel for Novell GroupWise to Exchange 

software speeds-up the migration process with this option. 

4.3.5 Do not save Calendar Items in Calendar View 

Select this checkbox to save the migrated calendar items in list view in MS Outlook instead of the default calendar 

view. 

4.4 Modifying GroupWise Folder Names as per Outlook/Exchange 

You can change the folder names of GroupWise mailbox while migrating to MS Outlook or MS Exchange Server. 

 

Figure 4.3 Modifying GroupWise Folder Names 

Select the checkbox “Change name of GroupWise folders while migrating to Outlook or Exchange” to activate the 

section where Default GroupWise Folders name, GroupWise folders and Outlook/Exchange Folders are listed. 

From here you can easily modify the folder names of GroupWise mailbox and MS Outlook/MS Exchange Server 

mailboxes for migration. After that click Apply button and then OK button. 

This option is supportive to Unicode language folder migration. 

5 Difference Between Evaluation and Full Version 
The free to download Evaluation version of Kernel for Novell GroupWise to Exchange is fully functional in its 

conversion capabilities. 

It converts your Novell GroupWise mailboxes and saves them in PST file or in MS Exchange Server mailbox. The 

demo version shows complete preview of the converted emails with data but will save only first 10 emails per 

folder existing in the User Mailbox to PST or MS Exchange Server. 
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Purchasing the Full version delimits the saving restrictions and saves as many user mailboxes as required by the 

user. 

6 Purchase and Support 
6.1 Purchase Kernel for Novell GroupWise to Exchange 

You must purchase Kernel for Novell GroupWise to Exchange software in order to save entire converted email 

messages of Novell GroupWise mailboxes. The free evaluation version of Kernel for Novell GroupWise to Exchange 

software lets you save 10 emails per folder of the converted GroupWise mailbox. 

You can purchase the Kernel software through KernelApps website: 

https://www.nucleustechnologies.com/migrate-groupwise-to-exchange.html 

Payment and Delivery 

Purchase the Kernel software with our authorized resellers, which provide number of payment options for your 

ease - PayPal, FAX, Credit Card, E-cheque, Pay Order etc. For other methods, please email us 

to sales@nucleustechnologies.com 

After making the purchase transaction with our resellers, we send you an email, which consists of activation details, 

and download link of the full version comprising of activation code. This email is sent to the mail address, which 

you have used while processing the purchase transaction with our resellers. 

 

 

6.2 Support Options for Kernel for GroupWise to Exchange 

Web Support 

Online Help: 

If you have queries relating to the use of Kernel for Novell GroupWise to Exchange software, you can visit our online 

help to have some more clarification to the usage of the software. 

Online Help:  https://www.nucleustechnologies.com/Online-Helps.html 

Knowledgebase: 

There is extensive knowledgebase, which deals with common queries relating to the software: 

Visit knowledgebase:  https://www.nucleustechnologies.com/supportdesk/ 

Chat Support: 

You can also get the help of our experts online by visiting our chat support section. You can communicate directly 

to our experts online. 

Chat Support:  https://www.nucleustechnologies.com/supportcenter/ 

 Important: It is advised to avoid using false email address while making the  purchase 

https://www.nucleustechnologies.com/migrate-groupwise-to-exchange.html
https://www.nucleustechnologies.com/Online-Helps.html
https://www.nucleustechnologies.com/supportdesk/
https://www.nucleustechnologies.com/supportcenter/
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Telephone Support 

Helpline: 

+91-9818725861 

1-866-348-7872 (Toll Free USA/CANADA) 

Email Support 

For Sales:  sales@nucleustechnologies.com 

For Support:  support@nucleustechnologies.com 

For General Queries: contact@nucleustechnologies.com 

7 Legal Notice 
This section comprises the legal specification about Kernel for Novell GroupWise to Exchange and the company 

KernelApps 

7.1 Copyright 

KernelApps Private Limited, Kernel accompanied user manual and documentation are copyright of KernelApps 

Private Limited, with all rights reserved. Under the copyright laws, this user manual cannot be reproduced in any 

form without the prior written permission of KernelApps Private Limited. No 

Patent  Liability  is assumed, however, with respect to the use of the information contained herein. 

© KernelApps Private Limited. All rights reserved. 

7.2 Trademark 

Kernel ® is a copyright work of KernelApps 

Windows 95®, Windows 98®, Windows ME®, Windows NT®, Windows 2000 Server®, Windows 2000 Advanced 

Server®, Windows 2003 Server®, Windows XP®, MS Outlook, MS-DOS, MS Office, MS Exchange Server and Novell 

GroupWise Client and Novell GroupWise Server are registered trademarks of Microsoft Corporation and Novell 

Inc. 

All other brand and product names are trademarks or registered trademarks of their respective companies. 

7.3 Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject to 

change   without notice. KernelApps Private Limited provides no warranty with regard to this manual or any other 

information contained herein and here by expressly disclaims any implied warranties of merchantability or fitness  

for any particular purpose with regard to any of the foregoing KernelApps Private Limited assumes no liability for 

any damages incurred directly or indirectly from any technical or typographical errors or omissions contained 

herein or for discrepancies between the product and the manual.In no event shall KernelApps Private Limited, be   

liable for any incidental, consequential special, or exemplary damages, whether based on tort, contract or 

mailto:sales@nucleustechnologies.com
mailto:support@nucleustechnologies.com
mailto:contact@nucleustechnologies.com


 

                                                                                      © KernelApps Private Limited 

                                                                        

Kernel for Novell GroupWise to Exchange Installation & Configuration Guide 

otherwise, arising out of or  in connection with  this manual  or any other information contained herein or the use 

there of. 

7.4 License Agreement 

Kernel for Novell GroupWise to Exchange software is Copyright work of KernelApps Private Limited. 

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing or distributing this software, 

unless you have a different license agreement signed by KernelApps Private Limited. 

The terms and conditions of this License describe the permitted use and users of each Licensed Copy of Kernel for 

Novell GroupWise to Exchange software. For purposes of this License, if you have a valid license, you have the 

right to use a single Licensed Copy of Kernel. 

Scope of License 

Each Licensed Copy of Kernel for Novell GroupWise to Exchange software may either be used by a single person 

or used non-simultaneously by multiple people who use the software personally installed on a single 

workstation. All rights of any kind in Kernel, which are not expressly granted in this License, are entirely and 

exclusively reserved to and by KernelApps Private Limited. You may not rent, 

lease, modify, translate, reverse engineer, decompile, disassemble, or create derivative works based on, Kernel, 

nor permit anyone else to do so. You may not make access to Kernel available to others in connection with a 

service bureau, application service provider, or similar business, nor permit anyone else to do so.  

Warranty Disclaimers and Liability Limitations 

Kernel for Novell GroupWise to Exchange software, and any and all accompanying software, files, data and 

materials, are distributed and provided as is and with no warranties of any kind, whether expressed or implied. In 

particular, there is no warranty for the quality of data recovered. You acknowledge that good data processing 

procedure dictates that any program, including Kernel, must be thoroughly tested 

with non-critical  data  before  there  is  any  reliance  on  it,  and  you  hereby  assume  the  entire  risk  of all  

use of the copies of Kernel covered by this License. This disclaimer of warranty constitutes an essential part of this 

License. In addition, in no event does KernelApps authorize you or anyone else to use 

Kernel for Novell GroupWise to Exchange software in applications  or systems where Kernel for Novell 

GroupWise to Exchange software failure to perform can reasonably be expected to result in a significant physical 

injury, or in loss of life. Any such use is entirely at your own risk, and you agree to hold KernelApps 

Private Limited harmless from any and all claims or losses relating to such unauthorized use. 

General 

This License is the complete statement of the agreement between the parties on the subject matter, and merges 

and supersedes all other or prior understandings, purchase orders, agreements and arrangements. This License 
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shall be governed by the laws of the State of Delhi. Exclusive jurisdiction and venue for all matters relating to this 

License shall be in courts and for a located in the State of Delhi, 

and you consent to such jurisdiction and venue. There are no third-party beneficiaries of any promises, 

obligations or representations made by KernelApps Private Limited herein. Any waiver by KernelApps Private 

Limited of any violation of this License by you shall not constitute, nor contribute to, a waiver by KernelApps of 

any other or future violation of the same provision, or any other provision, of 

this License.       

 


